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Abstract 12 

 Synchrotron X-ray diffraction images are increasingly used to characterize 13 

crystallographic preferred orientation distributions (texture) of fine-grained polyphase materials. 14 

Diffraction images can be analyzed quantitatively with the Rietveld method as implemented in 15 

the software package MAUD (Materials Analysis Using Diffraction). Here we describe the 16 

analysis procedure for diffraction images collected with high energy X-rays for a complex, 17 

multiphase shale, and for those collected in situ in diamond anvil cells at high pressure and 18 

anisotropic stress. 19 
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I. INTRODUCTION 24 

In a companion paper (Wenk et al., 2013), we have described the basic steps for texture 25 

analysis from synchrotron diffraction images with the Rietveld method, using the software 26 

MAUD (Lutterotti et al., 1997). We assume that the reader is familiar with the procedure. We 27 

will refer to some of the steps used for the general procedure from the companion paper with the 28 

corresponding number (e.g., Part I.3). Steps in this publication will be referred to only by 29 

number (e.g., 3). Here we discuss complexities which arise for samples with many phases and 30 

samples which are highly deformed.  31 

The first example is a sedimentary shale composed of multiple types of minerals, with 32 

different volume fractions, microstructures, and orientation distribution functions (ODFs). The 33 

second complex sample is magnesiowuestite (Mg,Fe)O measured in situ at ultrahigh pressure 34 

and anisotropic stress conditions with a diamond anvil cell (DAC). Keep in mind that we provide 35 

only an outline of analysis procedures. The Rietveld method and its implementation in MAUD is 36 

very general and lends itself to many applications, each of which may require slightly different 37 

approaches, modifications, and application of particular models. Data files for this tutorial can be 38 

freely downloaded from the internet (http://eps.berkeley.edu/~wenk/TexturePage/MAUD.htm). 39 

 40 

II. SHALE AS AN EXAMPLE OF A COMPLEX POLYPHASE MATERIAL 41 

A. Diffraction experiment 42 

Shale is a sedimentary rock composed of many minerals. Sheet silicates comprise a large 43 

volume fraction of shales and align preferentially parallel to the bedding plane during 44 

sedimentation and compaction. Crystallographic preferred orientation (CPO) of phyllosilicates is 45 

of great interest, because it is the primary cause of elastic anisotropy observed during seismic 46 

prospecting of oil and gas deposits. Thus several studies have focused on improving synchrotron 47 

X-ray techniques to quantify textures and microstructures of shales (e.g., Wenk et al., 2008; 48 

Lutterotti et al., 2010; Kanitpanyacharoen et al., 2011, 2012; Vasin et al., 2013). 49 

For this tutorial we use a sample of Kimmeridge shale from the North Sea, UK (Hornby, 50 

1998; Wenk et al.,2010; Vasin et al., 2013). The sample is a slab, 2mm thick (Fig. 1a). It was 51 

measured at the APS high energy beamline ID-11C during the same session as the nickel coin 52 

(Wenk et al., 2013). The wavelength is 0.10798 Å, and the beam size 0.5×0.5 mm. Therefore the 53 

same instrument parameters can be applied which were obtained by refining the CeO2 standard 54 
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(see Part I.1-13). During X-ray exposure, the sample was translated along the horizontal axis 55 

from –2.5 to +2.5 mm to increase the measured volume and rotated around the ω-axis (Fig. 1 in 56 

Wenk et al., 2013) from –45° to +45° in 15° increments (i.e., there are 7 diffraction images) to 57 

obtain adequate pole figure coverage. 58 

 Images were collected with a Perkin Elmer amorphous silicon detector with dimensions 59 

of 2048×2048 pixels and a pixel size of 200×200 µm. The detector was approximately 1850 mm 60 

from the sample. Figure 2a shows a diffraction image with many Debye-rings from at least six 61 

major phases. Several rings display strong intensity variations due to preferred orientation. 62 

 63 

B. Analysis for axial symmetry 64 

1. Start. Open a new analysis in MAUD  (“File → New → General Analysis”) and save it (“File 65 

→ Save analysis as…”) in your data directory (e.g. as Shale2012-axial.par). Refining seven 66 

datasets (2D diffraction images are integrated in 10° steps, resulting a total of 36x7 = 252 67 

spectra) simultaneously with a number of low-symmetry phases is time-consuming. Thus we will 68 

start with only one dataset measured at ω = 0°. The procedure with a single image is justified, 69 

because shale textures have approximately axial (cylindrical) symmetry about the bedding plane 70 

normal. By imposing this sample symmetry, complete pole figure coverage is obtained with only 71 

one dataset. 72 

 73 

2. Datasets. 74 

• General: Import calibrated diffractometer parameters (CeO2-2012.ins) as was done for 75 

the coin analysis (Part I.15). Restrict the refinement range to 2θ = 0.3 – 3.0° (Part I.8). 76 

Since this shale contains several low-symmetry phases, many peaks lie at higher 2θ due 77 

to higher order reflections that strongly overlap. They do not provide much information 78 

for texture analysis, and restricting the range will greatly speed up the computation. 79 

• Datafiles: Import the diffraction image (Part I.5-7). In ImageJ plugin, load Hornby-80 

long-00132-0.tif, then proceed with the same steps and values as for the CeO2 standard 81 

and nickel coin (Part I.5-7, Part I.15) (i.e. for image width/height size 2048×2048, pixel 82 

size 0.2×0.2 mm, detector distance 1850 mm, image rotation “rotate 90 degrees left to 83 

correctly account for your sample rotation axis, etc.). Save the .esg file (e.g., as “Hornby-84 

long-00132-0.esg”) in your data directory, and close ImageJ. As a reminder: Images need 85 
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to be rotated 90° left in ImageJ similarly to CeO2 and nickel coin (Part I.5). In Figure 3 86 

(bottom) the stack of experimental diffraction spectra is displayed. The pole figure 87 

coverage is shown in Figure 1b with the pole to the bedding plane at A (ω rotation axis). 88 

• Background function: 89 

o Polynomial–We will use a 4th order polynomial background common to all 90 

patterns. By default, MAUD provides three polynomial background 91 

coefficients, and two additional coefficients need to be added in the 92 

“DataFileSet” window under “Background function” tab in “Polynomial” 93 

(Part I.8). Right-click on each of the five background parameter values, and 94 

set them to “Refined”. 95 

o Background peaks–It is necessary to correct for small angle scattering from 96 

platelet-shaped phyllosilicate nanoparticles, which is best visible in the 97 

diffraction image (Fig. 2a) at very low angles (2θ ≈ 0.1-0.2°) close to the 98 

beamstop. Since these platelets are oriented also small angle scattering 99 

displays azimuthal intensity variations. The broad peak extends as elevated 100 

background to the first diffraction peaks of phyllosilicates (2θ ≈ 0.6°) (Fig. 3). 101 

To correct for it, we add two symmetrical background peaks. In “Background 102 

function” go to “Background peaks” and click “Add term” (Fig. 4). The first 103 

peak is assumed to have an intensity (“Height”) of 100,000, width in 2θ 104 

“HWHM” equal to 0.1°, width in eta (“HWHW (eta)”) of 30°, position along 105 

2θ (“Position”) of 0.1°, position along azimuth (“Position (eta)”) of 90°. Also 106 

set “Eta” = 1, and “Eta (eta)” = 0.5. These parameters control gaussianity of 107 

background peaks in 2θ and eta domains. Use the same parameters for the 108 

second peak, but change its “Position (eta)” to 270°. Double-click on 109 

background peak names to rename them. Right click on the “Height”, 110 

“HWHM” and “HWHM (eta)” boxes of both background peaks and choose 111 

the “Refined” option. 112 

• Save: Make sure to save the parameter file with .par extension and in the same folder as 113 

the .esg data files. 114 

 115 
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3. Phases. To reduce the refinement time in this tutorial we limit our refinement to the five major 116 

phases: quartz, pyrite, kaolinite, illite-mica, and illite-smectite. There are minor phases such as 117 

feldspars with less than 5% volume and no significant texture. Quartz and pyrite structures are 118 

included in structures.mdb file of MAUD (Part I.16). We provide crystallographic information 119 

files (.cif) for triclinic kaolinite (Bish and Von Dreele, 1989), monoclinic illite-mica (Gualtieri, 120 

2000), and monoclinic illite-smectite (Plançon et al., 1985). Refer to sections Part I.2, I.9, and 121 

I.16 for information on importing .cif and working with phases. For illite-mica and illite-122 

smectite, the first monoclinic setting has to be used (Matthies and Wenk, 2009). The provided 123 

.cif file for illite-smectite is already in the first setting. But you do need to “Edit” the illite-mica 124 

phase and under “General” change the space group from C2/c:b1 to C2/c:c1, which makes c the 125 

unique (2-fold) axis. Lattice parameters and atomic positions are adjusted automatically by 126 

MAUD. Rename the displays of mineral phases by double-clicking on their names.  127 

 128 

4. Sample. When multiple phases are entered, MAUD automatically assigns to each phase the 129 

same volume fraction. But with a complex sample like this shale, it is better to provide good 130 

initial estimates of phase volume fractions. Switch to “Sample” tab in the MAUD main window 131 

and “Edit” current sample. In “Layers” pick a phase from drop-down list in the right part of the 132 

window and enter a new value in the “Volume fraction” field. We start with 0.25 for quartz, 0.05 133 

for pyrite, 0.1 for kaolinite, 0.3 for illite-mica and 0.3 for illite-smectite. Weight fractions are 134 

calculated automatically by MAUD using the provided atomic structure.  135 

Also, to correctly impose axial symmetry for texture, the sample orientation in the MAUD 136 

reference coordinate system must be changed. Go to “Sample position” and set the Chi value to 137 

90°. This puts the bedding plane normal of the shale into the center of the reference pole figure 138 

(B in Fig. 1b). Axial symmetry of texture in MAUD is always imposed around this axis. 139 

 140 

5. Manual adjustments. Manual adjustments of parameters are best done in “Parameter list” 141 

(“Analysis → Parameters list” or “Ctrl” and “L” on a PC or “Command” and “L” on a Mac), 142 

expanding parameters, clicking on “Value” and selecting increment to decrease or increase the 143 

value by clicking on arrows. Results are automatically updated on the “Plot” display (Part I.12). 144 

• Start by pressing the “Calculator” button in the MAUD main window toolbar to view 145 

calculated spectra. At the bottom of the “Plot” display there appears a list of phases with 146 
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each phase name of different color (unless “Black & White” is selected in “Plot options”) 147 

(Fig. 5). For each phase positions of diffraction peaks are displayed. By right-clicking on 148 

the phase name in this list, and selecting one or several phases from the menu, individual 149 

contributions of selected phases are plotted with corresponding colors.  150 

• You may need to adjust some of the phase lattice parameters manually to shift position to 151 

a reasonable value. For this example, the overall calculated intensity is too low, and has 152 

to be adjusted manually to roughly match the experiment (Part I.18). Save your analysis 153 

before beginning refinements. 154 

 155 

6. Basic refinement. The sample is too complex to use the Wizard, and we will proceed with a 156 

mixture of semi-automatic refinement and manual (similar to Part I.10-12). Free and refine the 157 

parameters in the order listed below but first (in “Parameter list”) “Fix all parameters”. Then 158 

refine each parameter or parameter group until the fit has converged or is no longer visibly 159 

improving, then move on to the next parameter (usually, 4-6 iterations are enough). After you 160 

have refined a parameter, leave it free to refine, as you free and refine the next parameter in the 161 

list. If your refinement diverges, you may have to intervene with manual adjustments to bring the 162 

diverging parameters into a reasonable range. It is advised to save your analysis after each 163 

successful refinement (preferably to separate files, so that you can backtrack in case the 164 

refinement diverges and requires manual adjustments). 165 

• Intensity and backgrounds. In “Parameter list”, click “Free scale pars”. This will set to 166 

“Refined” the overall scale of the diffraction pattern and the phase volume fractions 167 

(except the first one that is adjusted each cycle so that volume fractions add to 1). We 168 

have already set manually all five polynomial background coefficients and background 169 

peak intensity and width to “Refined” (2). Refrain from clicking the “Free backgrounds” 170 

button as this would refine all background peaks parameters, including positions that are 171 

fixed.  172 

• Thermal factors. These diffraction data are not appropriate to refine thermal factors 173 

separately for each atom type, thus set them all equal. Click the “Bound B factors” button 174 

in the parameter list. This sets all thermal factors equal to the B factor of the first atom of 175 

the first phase in the list and sets this one to “Refined.” Run the refinement again. For 176 

these diffraction data with a narrow scattering angle range the refinement of the B-factors 177 
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is used as a 2θ dependent intensity adjustment, only remotely related to physical thermal 178 

vibrations. 179 

• Cell parameters. All cell parameters for quartz (a and c) and pyrite (a) are refined since 180 

these minerals contribute several distinct sharp peaks to the diffraction pattern. 181 

Phyllosilicate peaks are weaker and strongly overlapped; thus for kaolinite and illite-mica 182 

we will not refine cell angles, but only a, b and c. For illite-smectite, refine only the a 183 

parameter. MAUD offers a user-friendly approach for the refinement of these parameters. 184 

While in “Parameters list” enter the word “cell” into a search field at the bottom. This 185 

will make only cell parameters of all phases in the sample visible in the parameters list 186 

and you may quickly set up their “Refined” status without extensive browsing. 187 

• Make sure that you have refined the parameters specified above. Compare experiment 188 

and model on “Plot” and “Plot 2D” displays, check that all phase volume fractions are 189 

reasonable (e.g., no phases have 0% volume fraction) and that cell parameters did not 190 

change significantly from their initial values. 191 

• Detector position. Because the shale sample is not in the exact same position as the CeO2 192 

calibrant, the detector orientation relative to the sample is slightly different and should be 193 

refined. Set “Center displacement x,” Center displacement y,” “Tilting error x,” and 194 

“Tilting error y” (in “Datasets → Diffraction Instrument → Flat Image Transmission”) to 195 

refine. Close all windows and run the refinement. When the refinement is done, set these 196 

four parameters back to “Fixed.” 197 

 198 

7. Texture and microstructure refinement. In the “Plot 2D” display (Fig. 3), diffraction peaks of 199 

kaolinite, illite-mica, and illite-smectite show strong eta-dependent intensity variations indicative 200 

of texture. The intensities of the quartz and pyrite diffraction peaks are almost constant, except 201 

for several increased intensity spots due to scattering from larger grains. Thus we will only refine 202 

preferred orientations of the three phyllosilicates but not of quartz and pyrite. Note that some of 203 

the peaks have incorrect width. We need to refine microstructure parameters of phases to correct 204 

this. To setup the texture and microstructure refinement, proceed with the following steps. 205 

• Select kaolinite, edit the phase and in the “Microstructure” tab, ensure that the “Delf” line 206 

broadening model and the “Isotropic” size strain models are selected (see section VII in 207 

Wenk et al., 2013, for details and references). Click the “Options” button next to “Size-208 
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Strain model/Isotropic,” and in the new window, set both parameters (crystallite size and 209 

r.m.s. microstrain) to “Refined”. 210 

• Go to “Advanced models”, and select the E-WIMV model for texture (Part I.16). Click 211 

on the corresponding “Options” button. In the “E-WIMV options panel” select 10 212 

iterations and a 10° for “ODF resolution in degrees”. For “Generate symmetry” select 213 

“cylindrical”. Phyllosilicates in shale display almost perfect fiber texture, thus imposing 214 

axial symmetry is justified. To speed up the refinement, click “EWIMV advanced 215 

options” button. In “Min reflex intensity” enter 0.01. It means that all the diffraction 216 

peaks with intensity below 1% of maximum peak intensity for this phase will not be used 217 

for texture calculation. Close all windows (“OK”) to save changes and return to MAUD 218 

main window. Repeat this procedure for illite-mica. 219 

• For illite-smectite, with a highly disordered structure, we will use the “Standard 220 

Functions” for texture model and an appropriate stacking disorder model. The so-called 221 

“Ufer single layer” model uses a super-cell approximation (Ufer et al., 2004), and 222 

consequently the number of peaks fitting the pattern is increased by at least one order of 223 

magnitude. Due to an increased number of peaks and peak overlaps, the E-WIMV 224 

algorithm will run very slowly, and errors are possible when resolving diffraction peak 225 

overlaps. Thus the standard functions texture model is more appropriate in this case. 226 

•  “Edit” the illite-smectite phase, and proceed to the “Advanced models” tab then select 227 

“Standard functions” as a texture model. Click the “Options” button. In window “Texture 228 

options panel” click the “Add term” button in the “Fiber components” panel, and set 229 

“ODF background” = 0, “Intensity” = 0.7, “ThetaY” = 0, “PhiY” = 0 (fiber axis is normal 230 

to the conventional pole figure projection plane in MAUD), “ThetaH” = 90, “PhiH” = 0 231 

(fiber axis is parallel to a translation), “FWHM” = 30, and “Gaussian” = 0.5. Set 232 

“Intensity”, “FWHM” and “Gaussian” values to “Refined”, then click “OK”. 233 

• Go to the “Microstructure” tab of the phase options window. Click the “Options” button 234 

next to “Size-Strain model/Isotropic,” and in the new window change crystallite size to 235 

200 and r.m.s. microstrain to 0.01. Set both to “Refined”. Then select “Ufer single layer” 236 

as the “Planar defects model” and click “Options” button. In window “Single layer model 237 

options panel” set “Number of layers” = 10, “Stacking direction” = a, “Crystallite factor” 238 

= 1 (< 1 will produce additional peak broadening to (h00) type peaks), and “Microstrain 239 
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factor” = 1 (> 1 will produce additional peak broadening to (h00) type peaks). Refine 240 

“Crystallite factor” and “Microstrain factor”. 241 

• Leave crystallite size and r.m.s. microstrain at the default values (1000 Å and 8E10-4, 242 

correspondingly) for quartz and pyrite and set these to “Refined”. 243 

• Run the refinement. At the end of the refinement, the experimental and the calculated 244 

spectra should agree fairly well in the “Plot” (Fig. 5) and “Plot 2D” (Fig. 3) displays. 245 

There are deviations in relative intensities in the “Plot” display, because this is simply an 246 

average over all spectra, not considering the relative significance of the orientation 247 

distribution. Figure 5 compares two individual spectra (obtained in “Datasets →Datafiles 248 

→View”), one with scattering vectors parallel and one perpendicular to the bedding plane 249 

normal and a good agreement for both is observed. Table 1 lists refined volume and 250 

weight fractions for the phases. 251 

 252 

8. Plot pole figures. Go to the “Graphic → Texture plot” menu to view “Reconstructed intensity” 253 

of the pole figures(Part I.20). Select the “Active” boxes next to (001) for kaolinite (phase is 254 

chosen from “Phase” drop-down menu), and (200) for illite-mica and illite-smectite. Since we 255 

have imposed fiber symmetry, the pole figures are circular around the center with the maximum 256 

for the basal plane poles in the center (normal to bedding plane). In the “E-WIMV” window we 257 

have exported ODF’s of kaolinite and illite-mica in BEARTEX format (Wenk et al., 1998), then 258 

smoothed in BEARTEX with a 7.5° Gaussian filter and calculated pole figures. In the “Standard 259 

function” window we have also exported pole figures for illite-smectite. The pole figures are 260 

shown in Figure 6a in equal area projection. Note that illite-mica has the sharpest texture and 261 

illite-smectite shows the broadest distribution. Some data are summarized in Table 2. Save the 262 

parameter file. 263 

 264 

C. Analysis without imposing texture symmetry 265 

9. As a last step, we add the other six diffraction images to the analysis. We save the refinement 266 

which we just did under a different name (e.g. as Shale2012-nosymm.par).  267 

• We create a new dataset by duplicating the available set (“Edit → Duplicate object”) and 268 

“Edit” the copy by removing in “Datafiles” all datafiles in the list (select them all and 269 

click “Remove”), and then duplicate this new ‘empty’ dataset five more times.  270 
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• Load corresponding datafiles into the six new datasets following the procedure in Part 271 

I.5-8. Change the corresponding omega angles for each image (in “Datafiles → Modify 272 

Angles”, Part I.15). Rename the new datasets in the main MAUD window (e.g., assign 273 

corresponding omege angle values as their names). The pole figure coverage is now as 274 

shown in Figure 1c, but considering the 90° Chi rotation (4), is shown in Figure 1d. Save 275 

the parameter file.  276 

• Compute the model spectra, and review them in the “Plot” and “Plot 2D” displays. The 277 

calculated and experimental diffraction spectra should agree fairly well. Since all 278 

necessary phase parameters already have good starting values and are set to refine, there 279 

are only a few things that we need to adjust before final refinement. 280 

• Go to “Parameter list” (“Analysis→Parameters list” menu) and click “Free scale pars” to 281 

refine incident intensity values for datasets we just added. Second, change the texure 282 

function of illite-smectite from “Standard Function” to “E-WIMV”. For each of the 283 

phyllosilicate phases, go to “E-WIMV options panel” (see 7 and Part I.8) and change 284 

option under “Generate symmetry” to “none”. We now have enough data to proceed 285 

without ODF symmetry imposed. 286 

• Refine your data. 287 

 Pole figures of phyllosilicates, corresponding to those in Figures 6a but without imposing 288 

symmetry, are shown in Figure 6b. The pole figure coverage (Fig. 1d) indicates that during data 289 

collection the sample has been rotated around the center. The new pole figures show deviations 290 

from axial symmetry, particularly an elongation of the pole figure maximum in the vertical 291 

direction for (001) kaolinite as well as (100) illite-mica and illite-smectite. Comparing this with 292 

the coverage, we note that this distortion extends into the blind region and may be an artifact. 293 

This is further supported by the fact that maximum pole densities are higher if axial symmetry is 294 

imposed (Table 2). Only additional measurements with rotations around the other sample axes 295 

could verify if the preferred orientation pattern has perfect axial symmetry. In Figure 7 we also 296 

show pole figures (100) of kaolinite and (010) of illite-mica and illite-smectite that display a 297 

peripheral circle. Phase volume fractions for Kimmeridge shale without imposing sample 298 

symmetry are compared in Table 1 with results for axial symmetry. They are very similar. 299 

 300 

Page 10 of 45

Cambridge University Press

Powder Diffraction



For Review
 O

nly

 
 

 

11

11. For the Kimmeridge shale the final Rw factor is ≈ 15% and Rb is ≈ 10%. A few peaks are 301 

missing from the calculated diffraction pattern, some are too intense, and some have wrong 302 

shapes (e.g., Figs. 3, 5). The missing peaks are mostly due to feldspar that could be entered into 303 

the refinement. Anisotropic crystallite shapes and microstrains could also be imposed for 304 

phyllosilicates (Part I.7). We have used CeO2 powder to refine instrumental parameters (Wenk 305 

et al., 2013), but cerium oxide has no diffraction peaks at 2θ < 2°. Thus the function describing 306 

instrumental part of diffraction peak broadening (especially the asymmetry) is poorly suited for 307 

this shale with diffraction peaks down to 2θ ≈ 0.5°. Parts of the instrumental peak shape function 308 

(Caglioti parameters) can be refined in this example. 309 

 310 

III. DIAMOND ANVIL CELL IN RADIAL DIFFRACTION GEOMETRY 311 

A. Experiment 312 

Rietveld texture analysis of synchrotron diffraction images can be applied to study in situ 313 

deformation at high pressures with a diamond anvil cell in radial diffraction geometry (rDAC) 314 

(e.g., Wenk et al., 2006). This proves to be an important method to determine deformation 315 

mechanisms at ultrahigh pressures, as in the deep earth (e.g., Miyagi et al. 2010) to explain 316 

observed seismic anisotropy in the lower mantle and inner core, and to study crystal orientation 317 

changes during phase transformations (Miyagi et al., 2008; Kanitpanyacharoen et al., 2012b). 318 

The method can also be applied to analysis data from multi-anvil experiments such as D-DIA 319 

(e.g., Wenk et al., 2005).  320 

The geometry of a typical rDAC deformation experiment is shown in Figure 8a,b. 321 

Diamonds not only impose pressure but also differential stress that deforms crystals in the 322 

aggregate. The diamond cell is set up in radial rather than axial geometry, i.e. the X-ray beam 323 

passes through the sample perpendicular to the compression direction so that the diffraction 324 

image records reflections from lattice planes oriented parallel and perpendicular to compression 325 

(Fig. 2c). Preferred orientation is expressed in the azimuthal intensity variations, similar to the 326 

images of the shale (Fig. 2a). 327 

rDAC experiments have been performed at room temperature to pressures as high as 200 328 

GPa on iron (Wenk et al., 2000) and 185 GPa on MgSiO3 post-perovskite (Miyagi et al., 2010). 329 

More recently texture measurements have been made in the rDAC on magnesiowuestite 330 
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(Mg,Fe)O at 2273 K and ≈ 65 GPa, using a combination of resistive and laser heating (Miyagi et 331 

al., 2013). 332 

Contrary to the coin and shale experiments, we must take into account changes with 333 

pressure, and particularly the macroscopic stress field which imposes anisotropic elastic 334 

distortions of the lattice. As an example we use magnesiowuestite which has been previously 335 

investigated with rDAC experiments (e.g., Merkel et al. 2002; Kunz et al., 2007; Lin et al., 2009; 336 

Kaercher et al., 2012). This particular sample (Mg0.9Fe0.1)O has been described by Marquardt et 337 

al. (2009) and Miyagi et al. (2013). 338 

The rDAC experiment was performed at the high pressure beamline 12.2.2. of the 339 

Advanced Light Source in Berkeley. Magnesiowuestite powder was loaded into a boron-kapton 340 

gasket. The initial sample diameter was 80 µm with a starting thickness of 50 µm. The sample 341 

was compressed in an rDAC, using diamond anvils with 300 µm diameter culets (Fig. 8c). 342 

Diffraction images were recorded with a Mar3450 image plate detector, with dimensions of 343 

3450×3450 and a pixel size of 100×100 µm, positioned approximately 285 mm from the sample 344 

and an X-ray wavelength of 0.49594 Å. 345 

There are two immediate complications. First, the beam passes not just through the 346 

sample but also through a gasket, which is needed to maintain pressure. Thus there are additional 347 

diffraction lines from the gasket material, especially at low angles (Fig. 2c). Gaskets for radial 348 

DAC experiments must be made of materials that scatter as little as possible. At lower pressures, 349 

amorphous boron (< 100 GPa) has been used, while at higher pressure, cubic boron nitride or 350 

beryllium have been used. For beryllium which scatters more, it is advantageous to tilt the cell 351 

slightly to have minimum beam interference. Bright diffraction spots from the diamond may also 352 

appear in the diffraction pattern. In fact, the large spot on the right side of Fig. 2c is attributed to 353 

diamond. This effect can be minimized by slightly rotating or tilting the DAC. If the cell is tilted 354 

significantly, the tilt needs to be accounted for in the analysis (Merkel, 2006). This is done by 355 

entering the appropriate sample rotation angles in MAUD.  356 

A second complication is imposed anisotropic elastic strain. Lattice plane spacings are 357 

smaller in the compression direction and larger perpendicular to the compression axis. Thus, the 358 

Debye rings are not circles but ellipses. The resulting sinusoidal variations od diffraction peak 359 

positions with azimuthal angle are best seen in unrolled images (Fig. 9a, bottom). 360 

 361 
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B. Initial setup 362 

12. Instrument calibration. Before analyzing the MgFeO diffraction pattern, instrument 363 

parameters should be refined with a standard sample. In this case LaB6 is used 364 

(Lab6_001.mar3450). Start a new general analysis file, and save it as “LaB6-2012.par”. The 365 

diffraction image (Fig. 2b) is quite spotty, indicative of large grain size which is not ideal, 366 

especially for refining Caglioti parameters. Before using Mar images in MAUD, they have to be 367 

converted to 16 bit TIFF images. This can be done in Fit2D (Hammersley, 1998; be aware that 368 

sometimes coordinate axis could be inverted or intensities and image size adjusted when doing 369 

image conversion with Fit2D) or preferably with the marcvt utility distributed by MarResearch.  370 

Latest versions of marcvt for Linux, MacOS and Windows are freely available at 371 

http://www.marresearch.com/download.html. Running marcvt in Microsoft Windows systems 372 

requires Cygwin (http://www.cygwin.com/) with libjpeg7 and libpng12 packages. During 373 

installation of Cygwin, when prompted to select packages for the installation, uncheck “Hide 374 

obsolete packages” box. Afterwards, search for libpng12 (in All/_obsolete subfolder) and 375 

libjpeg7 (in All/Graphics subfolder). After setting libpng12 and libjpeg7 for installation, press 376 

“Next” button and Cygwin will be installed on your computer. Put the marcvt.exe program into 377 

the “bin” subfolder of the Cygwin installation folder. You must also have Administrator rights 378 

when opening the Cygwin console and running the marcvt application. 379 

After you made the appropriate .tiff image, proceed with instrumental setup in MAUD 380 

(see Part I.1,4-13 for details). Follow directions in Part I.1 but enter 0.49594 Å for wavelength 381 

and 285 mm as sample-detector distance. Follow step Part I.5 and load the LaB6 TIFF image. In 382 

ImageJ specify correct Mar3450 image plate detector size (3450×3450 pixels) and pixel size 383 

(0.1×0.1 mm). Also, do not apply the image rotation (“Image→Rotate→Rotate 90 Degrees 384 

Left”) in ImageJ. We have only one diffraction image of magnesiowuestite, thus we do not need 385 

the image reorientation that was necessary to correctly account for the orientation of the 386 

horizontal sample rotation axis for beamline 11-ID-C, described for nickel coin (Part I.5, Part 387 

I.15) and shale (2). 388 

Proceed with with Part I.6. The image is not well-centered, and you must manually 389 

specify estimated detector center coordinates to avoid major distortions of peak positions on 390 

different integrated spectra. You will find a reasonable alignment by setting “Center X (mm)” = 391 

172.9 and “Center Y (mm)” = 154.9. Integrate image in 5° sectors (“Number of spectra” = 72). A 392 
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reasonable 2θ range for the refinement is 6.0-23.5° For “Background function” we use 393 

“Polynomial” with five parameters (Part I.8). 394 

Add a LaB6 phase as described in PartI.9. The NIST-recommended cell parameter for 395 

LaB6 is a = 4.15689 Å, crystallite size is 7000 Å, and microstrains are close to zero (set to 1.0E-396 

5). 397 

When you calculate spectra with these parameters, you will notice in the “Plot” display of 398 

the MAUD main window additional peaks at 2θ ≈ 8.5°, 13.5°, 17.5° and 20.7° due to some 399 

sample contamination. “Edit” current dataset, go to the “Excluded regions” tab and click “add 400 

term” button. One excluded region will appear in the list. Input values for “Min in data units” 401 

and “Max in data units” (2θ). We recommend excluding regions 2θ ≈ 7.5-9°, 10.5-14.5°, 17.2-402 

19°, 20-21.3°. This is an example of how to exclude “undesirable” data from the refinement. 403 

Note that it also excludes a couple of LaB6 peaks, overlapped with the contamination. 404 

In the “Plot 2D” display, experimental diffraction peaks are hardly visible because of few 405 

very intense “spots” originating from diffraction from a few very large grains. To deal with this 406 

we select “arbitrary tex” as “Texture model” for LaB6 (Part I.9). In general it would be 407 

advisable not to use such a coarse-grained impure standard (Fig. 2b). 408 

For the refinement of instrument parameters proceed like it is described in Part I.11-12. 409 

In this case you should not refine “Asymmetry” parameters as the measured diffraction peaks are 410 

far from image center and thus do not show any broadening asymmetry. Also in this case there is 411 

no eta angle dependent broadening. Repeat the refinement until convergence. Save instrument 412 

parameters as LaB6-2012.ins (Part I.13). 413 

 414 

13. Start analysis for the magnesiowuestite DAC image. First, import the instrument parameters 415 

which you have just refined (LaB6-2012.ins). Next, convert the diffraction image of 416 

magnesiowuestite (MgFeO_25keV_Z3_004.mar3450) into .tiff format (11), and import it into 417 

MAUD following the same procedure as you just did for LaB6. Unlike the coin and the shale 418 

samples, here you have only one diffraction image. Integrate it in 5° sectors to make 72 .esg files 419 

with individual spectra (in ImageJ). This smaller integration step is essential in this case, because 420 

there is a sharp texture and significant peak shifts due to anisotropic stress. If the integration step 421 

is too large, the variations of diffraction peak positions and intensities can not be accounted for 422 

properly. Note when the red (tracker) circle is superposed in ImageJ that the diffraction rings are 423 
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not circles but ellipses. They are elongated in the vertical direction (compression direction in the 424 

DAC). Also, the sides of the round image are cut by straight shadows originating from the rDAC 425 

cell. Do not forget to select the same image center as for the LaB6 standard when in ImageJ 426 

(“Center X (mm)” = 172.9 and “Center Y (mm)” = 154.9). This will keep your previous beam 427 

center and detector tilt calibration valid. 428 

In the “General” tab in the Datasets window, choose a “Computation range” from 11° to 429 

22° (Part I.9) in order to include the three prominent diffraction peaks (111), (200) and (220) of 430 

magnesiowuestite (Fig. 9, 10). 431 

 432 

14. View the spectra in “Plot” and “Plot 2D” displays. In the “Plot” display the 433 

magnesiowuestite peak at ≈14.3 Å is strangely distorted and in the “Plot 2D” display, it is 434 

evident that this distortion is due to one excessively intensive peak in diffraction spectra #64 and 435 

#65. This is the diffraction peak from the diamond anvil (Fig. 2b). Remove this spectrum (“Edit” 436 

the dataset, and in “Datafiles”, select spectrum #64 (this number is indicated in brackets after the 437 

datafile name) and click “Remove”. Do the same for the spectrum #65. Alternatively these files 438 

could be kept in the analysis but not used in the refinement by unchecking the “Enabled” box in 439 

the same window. Some spectra may be much weaker (e.g., they are shielded by the beamstop). 440 

These could also be removed from the analysis or disabled. 441 

 442 

15. Setting up the background in rDAC experiments can be difficult due to scattering and 443 

absorption from gaskets and DAC absorption effects (Fig. 2c, 9, 10). In this case it is best to use 444 

interpolated backgrounds. This is done by editing the “Dataset” and going to “Background 445 

function”. Remove all parameters for the “Polynomial” function (select parameter in the panel 446 

and click “remove parameter”), then go to the “Interpolated” tab. Check the “Interpolated 447 

background” option and enter 10 in the “Points for interpolation” field. Next click “Set 448 

interpolation points manually”. A diffraction spectrum will appear in a new window. Select 449 

“Tools → Edit interpolated background points”. A set of 10 automatically created points will be 450 

displayed. Some points lie in between peaks, corresponding to the “true” background, but some 451 

are located on diffraction peaks. Right-click on a position on the spectrum and select “add” or 452 

“remove” from the drop-down menu, in order to add or remove interpolated background points. 453 

All background points should be added where intensity is minimal (Fig. 10). Warning: in some 454 
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Microsoft Windows and OSX systems and computers with nVidia graphic cards, display of the 455 

points may not work correctly. Close the window and reopen it to see the interpolated 456 

background points. You may need to repeat the interpolated background setup several times, 457 

until all the points are well located. 458 

 459 

16. Next load the appropriate phase using a provided structure file (MgFeO.cif). MgFeO.cif is a 460 

magnesiowuestite with 10% Fe substituting for Mg, which is specified in atom site occupancies. 461 

Calculate model spectra with the “Calculator” button on the toolbar and review the experimental 462 

and calculated diffraction patterns (Fig. 9a). Due to the high pressure applied, experimental 463 

diffraction peaks are shifted toward higher 2θ values. 464 

 465 

17. Sample. With only one image and three diffraction peaks, the coverage is largely insufficient 466 

to refine the ODF. But in this DAC experiment texture should have axial symmetry around the 467 

compression direction. In MAUD, imposing axial symmetry of strain and texture requires the 468 

symmetry axis to be perpendicular to MAUD reference pole figure plane. Edit “Sample” in the 469 

MAUD main window and in “Sample position” tab set the Chi value to 90°. This will bring the 470 

compression direction into the center of the MAUD reference pole figure. The coverage (after 471 

this rotation) is shown in Figure 8d. First the compression axis is at A and after the Chi rotation it 472 

is at B. 473 

 474 

18. Once the instrument, data files, and phase information are loaded, you will need to manually 475 

adjust several parameters to get a closer fit to the data before MAUD can run refinements. 476 

• Intensity. Adjust the incident intensity (“_pd_proc_intensity_incident” parameter) until it 477 

is close to the data (Part I.12 and I.18). 478 

• Backgrounds. If using polynomial backgrounds, adjust the first global background 479 

coefficient: “_riet_par_background_pol0” parameter (located in the parameters list just 480 

above the intensity parameter) until the background intensity is close. If you are using 481 

interpolated backgrounds like suggested in (15), skip this step. 482 

• Unit cell parameters. Since these experiments are at high pressure, you need to decrease 483 

the cell parameter “_cell_length_a” (sections Part I.12 and I.17) until the calculated peak 484 

positions roughly correspond to observed peaks. 485 
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• Crystallite size and isotropic microstrain. Adjust the crystallite size 486 

“_riet_par_cryst_size” and microstrain “_riet_par_rs_microstrain” until peak width fits 487 

(Part I.9). Take into account that in the “Plot” display, broadening of peaks is partially 488 

due to peak position variations. In this case good starting estimates for crystallite size and 489 

microstrain are 300Å and 0.002, respectively. 490 

 491 

C. Stress models 492 

19. Macrostress. Lattice strain is due to the imposed anisotropic elastic stress and the elastic 493 

properties of the crystal. It is exhibited as sinusoidal oscillations in peak position with azimuth. 494 

An example of sinusoidal variations with azimuth can be seen in the “Plot 2D” display at the 495 

bottom of Fig. 9a. At this point the calculated fit has no dependence of peak position on azimuth 496 

because anisotropic stress has not yet been considered in the model. For radial DAC data with 497 

anisotropic stress, check the “Plot 2D” display for a good fit for elastic stress rather than the 498 

“Plot” display. The “Plot” display shows an average over all spectra, making peaks appear 499 

broader due to angle-dependent lattice strain. 500 

There are four models in MAUD that can be used to fit lattice strains, resulting in 501 

diffraction peak shifts Two are “stress models” that convert lattice strains to macroscopic stress 502 

tensor components, using provided elastic properties of the material. The other two models fit 503 

lattice strain distributions and leave it up to the user to calculate stresses by hand. 504 

In axial compression experiments in the DAC, the anvils impose both hydrostatic stresses 505 

(pressure) and differential stresses. The symmetric stress tensor σij can be separated into 506 

hydrostatic σp and differential stress Dij components such that: 507 

 508 

 

509 

 510 

where t is the axial stress component and provides lower bounds for the yield strength of the 511 

material (Singh, 1993; Singh et al., 1998). Thus, during refinement of the stresses, the 512 

differential stresses should be constrained such that σ11 = σ22 and σ33 = -2σ11, where σ33 is the 513 

largest principal stress in the compression direction and is negative (corresponding to 514 
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compression), according to the conventions in MAUD. For the analysis described here only 515 

deviatoric stresses will be fit with the stress model. Hydrostatic stresses are accounted for by 516 

refining unit cell parameters, which in turn can be converted to pressure by utilizing an 517 

appropriate equation of state (see below). The reason for treating these separately is that 518 

differential stresses will be calculated assuming a linear stress-strain relationship which is only 519 

applicable for small strains. The volume changes of the unit cell due to pressure effects are 520 

significantly larger than those due to differential stress, and it is best to use an equation of state 521 

which properly accounts for the nonlinearity of stress-strain dependence at larger compressions. 522 

On the other hand, for the analysis of the residual stresses, e.g., in engineering materials, where 523 

stress tensor components values are often within a 0.5 GPa range, it is appropriate to keep initial 524 

lattice parameters fixed. One should then only fit either stress or strain values. 525 

To set up a stress model, select the phase from the “Phases” tab in MAUD main window 526 

and edit it. In “Advanced models” select one of the following models from the drop-down list in 527 

the “Strain” section: 1) “Triaxial Stress Isotropic E”, 2) “Moment Pole Stress”, 3) WSODF Popa-528 

Balzar, or 4) “Radial Diffraction in the DAC”. 529 

We will briefly describe each model and how to set it up for the refinement. 530 

 531 

20. Triaxial Stress Isotropic E. This model assumes an isotropic material and as a result 532 

generally does a poor job of fitting stresses in textured material with pronounced single-crystal 533 

elastic anisotropy. But fairly isotropic materials (e.g., zirconium) can be described with it and it 534 

can be applied for materials where single crystal elastic properties are unknown and you are not 535 

concerned about precise determination of stresses and want to fit textures only. 536 

• Once you have selected “Triaxial Stress Isotropic E” click the “Options” button next to it. 537 

• Enter the Young’s modulus and Poisson ratio for the material being analyzed. To obtain 538 

an accurate estimate of stresses, you will need to use the Young’s modulus and Poisson 539 

ratio derived at actual high pressure value. 540 

• Fix the macrostresses with σij = 0 for i ≠ j, σ11 = σ22, and σ33 = -2σ11. To fix parameters, 541 

right click on the “Macrostress22” value and select “Equal to” from the drop-down menu. 542 

This will open the “Parameter binding” window. Scroll down until you find a parameter 543 

named “_rista_macrostress_11” for your current phase and select it from the list (in this 544 

case with only one phase, it should be near the very end of the parameter list). Enter 1 in 545 
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the “x” box, and 0 in the “+” box. This means that “Macrostress22” will be set to 1 * x, 546 

“Macrostress11” + 0. Set “Macrostress33” equal to (-2) times “Macrostress11”. Now that 547 

the stress interdependencies are set, adjust or refine only “Macrostress11”. All other 548 

stress values will be adjusted automatically. 549 

• Next, manually adjust “Macrostress11” until the sinusoidal variation in peak position in 550 

the calculated spectra is close to variations in the observed spectra in the “Plot 2D” 551 

display. Generally the off-axis compressive stress should be less than on-axis, thus the 11 552 

differential stress components should be positive. 553 

 554 

21. Moment Pole Stress. This model is based on (Matthies et al., 2001) and requires the elastic 555 

tensor (Cij), corrected for pressure, for the material of interest (Figure 11). This is the most 556 

sophisticated model of the four. It calculates diffraction elastic constants for each diffraction 557 

peak of the material, taking preferred orientation into account, using different micromechanical 558 

models similar to those used for calculating bulk polycrystal properties (i.e., Voigt, Reuss, Hill, 559 

GEO). The only difference is that for calculation of diffraction elastic constants crystal properties 560 

should be averaged, using “moments” of ODF or pole figures (corresponding values weighted by 561 

sine or cosine values of certain angles). 562 

• Once you have selected the “Moment Pole Stress” model, click the “Options” button to 563 

open the “Moment pole figures options panel”. 564 

• Fix the macrostresses as described above with σij = 0 for i ≠ j, σ11 = σ22, and σ33 = -2σ11.  565 

Again you will only adjust or refine “Macrostress11”. 566 

• Enter the single crystal stiffnesses (Cij, in two-index Voigt notation) for the material of 567 

interest. Note that the elastic tensor is in general pressure-dependent, and it is important 568 

to enter correct values for the given pressure, or the stresses obtained from the model will 569 

be incorrect. 570 

• In the “Stress/strain model” box in the top right choose the desired stress model. Voigt, 571 

Reuss, Hill, PathGEO, and BulkPathGEO are available. If you choose the Hill model you 572 

can adjust the “Weight (Voigt-Reuss)” value to get resulting arithmetically averaged 573 

elastic constants closer to either Voigt or Reuss boundary. In almost all cases the 574 

BulkPathGEO model is preferable. It satisfies a physically grounded “inversion relation” 575 

(i.e., stiffness is inverse compliance) for each aggregate of grains contributing to a 576 
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diffraction peak and also for the sample on the macroscopic scale (the latter is not true for 577 

the simpler PathGEO model). 578 

• You can include the effects of texture by checking the “Use texture ODF” box. In fact, 579 

you are strongly advised to always do so, since differently oriented crystallites are 580 

deformed differently by the mean stress field, and their deformation in general depends 581 

on elastic constants of the material and thus on the texture. Texture effects will only be 582 

accounted for if the “E-WIMV” model is used for the texture description. 583 

• Adjust the “Macrostress11” value until the sinusoidal variation in peak position 584 

resembles the data. 585 

 586 

22. WSODF Popa-Balzar. The model, described in (Popa and Balzar, 2001), in its MAUD 587 

implementation does not provide the macrostress tensor components directly. It introduces an 588 

orientation distribution function for each strain (and consequently, stress) tensor component that 589 

is weighted according to ODF values. So, in addition to the crystal ODF, there are generally six 590 

weighted strain ODFs (WSODFs). These WSODFs are expressed as series expansions using 591 

spherical harmonics. This method is the least user-friendly, and an inexperienced user may find it 592 

very difficult to adjust all the values manually. Thus we give only a short outline of it. 593 

• Once you have selected the “WSODF Popa-Balzar” model click the “Options” button 594 

next to it. This will open the “Harmonic strain options panel”. 595 

• Select “fiber” as the “Sample symmetry”. You can control the length of the series 596 

expansion with the slider bar; it should be at least 4. Since this DAC experiment is 597 

believed to be centrosymmetric, all the off-diagonal strain components should be set to 598 

zero and not refined. 599 

• After the series expansion coefficients are refined, macrostrain can be calculated by 600 

clicking the “Compute macrostrain” button (coefficients will appear in a console 601 

window). Strain distributions in the sample may be plotted as pole figures (in the MAUD 602 

main window, select “Graphic → Texture plot” and “Plot” the “Reconstructed strain”). 603 

The macrostress tensor may be calculated with a micromechanical model. 604 

 605 

23. Radial Diffraction in the DAC. This model is also not a true “stress” model. While previous 606 

models can be applied to more complicated deformation geometries, “Radial Diffraction in the 607 
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DAC” can only be applied to axial compression. The main advantage of this model is that it 608 

allows the user to fit lattice strains for each peak separately whereas previous models imply that 609 

all the displacements of diffraction peaks correspond to one macrostress tensor, or they are 610 

restricted by crystal symmetry. The “Triaxial Stress Isotropic E” and “Moment Pole Stress” 611 

models may fail if plastic anisotropy of the material is high. In the case of magnesiowuestite 612 

some peaks exhibit much higher lattice strains than other peaks, and these two models may not 613 

be able to provide a satisfactory fit to the data. 614 

The “Radial Diffraction in the DAC” model is built on the model of Singh (1993) and 615 

Singh et al. (1998). This model fits a Q(hkl) factor to each diffraction peak based on peak 616 

displacement and the angle to the principal stress axis. 617 

• If you have selected the “Radial Diffraction in the DAC” model, click the “Options” 618 

button. This will open the “DAC radial diffraction options panel” (Fig. 12). 619 

• The first two boxes are titled “Alpha” and “Beta”. “Beta” is the angle between the sample 620 

Z-axis and the maximum stress direction. “Alpha” is a rotation around Z. These two 621 

angles allow you to refine the orientation of the maximum stress axis in case it deviates 622 

from the sample Z-axis. This does happen fairly frequently at high pressures as the tips of 623 

diamond anvils deform elastically and become cupped. For now we will leave these set to 624 

zero. 625 

• The following boxes titled “Q(hkl)” are the Q(hkl) factor for each lattice plane given in 626 

the parentheses. Q(hkl) should be positive and generally falls in the range of 0.001 to 627 

0.007. A good initial estimate is 0.003. Enter it for the three peaks (111), (200) and (220) 628 

in the refinement range. 629 

• Manually adjust each Q(hkl) until the lattice strains in the model are close to the observed 630 

data. 631 

 632 

24. Checking Sample Orientation. If the stresses appear to be inverted, i.e., “Macrostress11” or 633 

Q(hkl) values are negative or the sinusoidal variations in peak positions are offset from the data 634 

by 90º (azimuth), then likely the sample orientation is wrong. Check that all the angles for each 635 

spectrum, dataset and whole sample correspond to experimental geometry. To check angles for 636 

individual spectra in a dataset, edit the dataset in the MAUD main window. Click on the 637 

“Datafiles” tab and ensure that angles under “Selected spectrum options” in the “Datafiles” tab 638 
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are set properly. To check sample orientation, edit the “Sample” in the MAUD main window, 639 

click on the “Sample position” tab where sample orientation angles “Omega”, “Chi”, and “Phi” 640 

can be adjusted. An alternative for assignment of certain angles to datafiles, or sample rotation in 641 

the “Sample” tab is to rotate the diffraction image in ImageJ when creating the .esg files, e.g. by 642 

90°. As we mentioned earlier (17), for the refinement the compression axis needs to be in the 643 

center of the pole figure. 644 

You can check if the sample orientation is correct by going to “Graphic → Texture plot” 645 

in the main MAUD window. Select “Pole figure coverage” and “Plot” it. By disabling and re-646 

enabling different spectra in the current dataset and plotting actual pole figure coverage you may 647 

see how different angles and orientations are related. In our case the pole figure coverage is 648 

shown in Figure 8d. 649 

 650 

25. Correcting Young’s Modulus and Poisson Ratio or Cij to Pressure. As mentioned above, you 651 

must correct the elastic moduli to pressure should you choose to use the “Triaxial Stress 652 

Isotropic E” or the “Moment Pole Stress” models. Elastic moduli are pressure dependent and 653 

often become larger as pressure increases or may display critical behavior near phase transitions. 654 

To correct elastic moduli for pressure, you will need an appropriate equation of state for your 655 

sample and a set of elastic moduli either calculated or experimentally determined for a range of 656 

pressures for your material. If your experiment is also at high temperature, you will need to 657 

correct for this as well and will also need to know the temperature dependence of elastic 658 

constants. In addition, you must account for possible anisotropic thermal expansion of the 659 

sample. 660 

The easiest way to correct the elastic moduli is to create a spreadsheet which uses an 661 

equation of state, such as a 3rd order Birch-Murnaghan equation of state, to calculate pressure 662 

from the fitted unit cell parameters. Next, plot each elastic coefficient (e.g., C11, C22, C33, C12 etc. 663 

or Young’s modulus and Poisson’s ratio) versus pressure. Once this is done, calculate a best fit 664 

line to each of the elastic constants and determine the equation describing the pressure 665 

dependence for each constant. This will allow you to extrapolate or interpolate elastic moduli to 666 

any reasonable pressure. Often a linear extrapolation will be good enough. Now use the pressure 667 

calculated from your unit cell parameters to determine the appropriate value of the elastic moduli 668 

using the equations for your best fit lines. You may need to perform several iterations of this 669 
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before the unit cell parameter and stress values stabilize.  In other word you will need to 670 

calculate the pressure from the unit cell parameter, correct the elastic moduli to the pressure, 671 

input the corrected elastic moduli, and run the refinement in MAUD. After doing this you may 672 

notice that the unit cell parameter has changed.  If so you will need to repeat the previous 673 

procedure until the unit cell parameter (and the corresponding pressure value) stabilizes. 674 

 675 

D. Refinement 676 

26. Refine Parameters. We are ready to begin the refinement. The conditions are too complex to 677 

use the Wizard, and we will proceed with a mixture of semi-automatic refinement and manual. In 678 

the “Parameter list” click “Fix all parameters,” and save the analysis in the MAUD main 679 

window. Proceed by freeing and refining the parameters in the order listed below. Refine each 680 

parameter or parameters until the fit has converged or visibly is not getting better, then move on 681 

to the next parameter. After you have refined a parameter, leave it free to refine as you free and 682 

refine the next parameter in the list. If your refinement diverges you may have to intervene with 683 

manual adjustments. 684 

• Intensity and backgrounds. Here we use interpolated backgrounds, so we refine only the 685 

intensity. In the “Parameter list” click “Free scale pars” and refine. 686 

• Unit cell. In the case of cubic symmetry such as with magneioswuestite, we refine only 687 

“_cell_length_a”. 688 

• Texture. As seen in the “Plot 2D” display the texture is fairly sharp, thus we may refine 689 

the texture early. Select the “E-WIMV” texture model for MgFeO. In the “E-WIMV 690 

options panel” select 10 iterations for the texture refinement using the slider bar and a 5° 691 

resolution. For “Generate symmetry” start with “none”. Once a sample orientation and a 692 

texture that is compatible with axial symmetry is verified with pole figure plots (Fig 13a), 693 

“cylindrical” sample symmetry should be imposed (Fig. 13b). This greatly improves the 694 

effective pole figure coverage. 695 

• Crystallite size and r.m.s. microstrain. Here we assume isotropic crystallite size and 696 

microstrain. In the “Parameter list” click the “Free microstructure” button and refine. As 697 

mentioned earlier, with the coarse-grained LaB6 standard it is difficult to refine the 698 

instrument peak shape, and thus refined crystallite size and microstrain of 699 

Page 23 of 45

Cambridge University Press

Powder Diffraction



For Review
 O

nly

 
 

 

24

magnesiowuestite would not be accurate. Be aware that a negative crystallite size is 700 

physically meaningless and indicates that your calibration is wrong. 701 

• Stress model. For “Moment pole stress” enter the elastic tensor components for your 702 

model. For magnesiowuestite at atmospheric pressure these are C11 = C22 = C33 = 279.5 703 

GPa, C12 = C13 = C23 = 102.2 GPa, C44= C55 = C66 = 142 GPa, all others are zero 704 

(Marquardt et al., 2009). For “Triaxial Stress Isotropic E” our starting estimation of 705 

Young’s modulus is 290 GPa, and of Poisson ratio is 0.2. Either free “Macrostress11” if 706 

you used the “Triaxial Stress Isotropic E” or the “Moment Pole Stress” models or free the 707 

Q(hkl) factors of all the peaks in the refinement range if you used the “Radial Diffraction 708 

in the DAC” model (see discussion on model selection and parameters binding for all 709 

these models in steps 20-23). For the “Radial Diffraction in the DAC” model, some 710 

values of Q(hkl) may diverge during refinement if these peaks are of weak intensity or 711 

are not well resolved due to peak overlaps. If this happens you need to fix the appropriate 712 

Q(hkl) parameter to a reasonable value, or just exclude this peak from the refinement. 713 

• Cell parameters and elastic constants should correspond to the same pressure. Once the 714 

stress model has converged, use the unit cell parameters to recalibrate pressure. If using 715 

the “Triaxial Stress Isotropic E” or “Moment Pole Stress” models, correct the Young’s 716 

modulus and Poisson ratio or the Cijs, to the new result for pressure and refine the 717 

stresses again. Repeat this process until the stresses and unit cell parameters correspond 718 

to the same pressure. You may also do the initial refinement with “Radial Diffraction in 719 

the DAC” model. Then, once cell parameters (and thus pressure) are confirmed, you may 720 

switch to the “Moment pole stress” model and enter the pressure-corrected Cijs (use Table 721 

2 from Marquardt et al., 2009 to estimate pressure from the cell parameter value and their 722 

Table 3 to get Cij values for this pressure). Comparison of our refinement results at this 723 

point with the equation of state (Marquardt et al., 2009), suggests that our pressure value 724 

is close to 34.3 GPa (refined cell parameter is ≈ 4.008 Å and corresponding volume is ≈ 725 

64.38 Å3). Thus appropriate the Cij values that should be used for the determination of 726 

anisotropic elastic stress tensor are C11 = C22 = C33 = 578.3 GPa, C12 = C13 = C23 = 161.9 727 

GPa, C44 = C55 = C66 = 141.4 GPa, and all others are zero. 728 

• Thermal factors. Click “Bound B factors” button in the parameter list to refine them all to 729 

the same value. With our limited 2θ region we cannot refine these realistically; they will 730 
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serve only as an additional correction parameter to overall peak intensities. Click “Bound 731 

B factors” and refine. 732 

• Beam center. If your stresses are not fitting well and you observe variations of peak 733 

position with angle eta, refine the beam center since it may have changed during DAC 734 

positioning. After refining, fix the beam center before continuing with the refinement. 735 

• If there is evidence that the compression direction is tilted, then you may correct for this. 736 

If using the “Radial Diffraction in the DAC” model, refine the “Alpha” and “Beta” angles 737 

for a better fit. If using the “Triaxial Stress Isotropic E” or the “Moment Pole Stress” 738 

models, you may refine the sample orientation angles in “Sample” (refer to step 17) to 739 

bring the compression axis normal to the MAUD reference pole figure projection 740 

(corresponding to the sample Z axis). After refinement, fix these before continuing.To 741 

improve the fit further, you may also refine the occupation of oxygen atoms (as 742 

(Mg,Fe)O could be non-stoichiometric). 743 

 744 

27. Heterogeneities of strain in the DAC cell. In the “Plot 2D” display you may observe 745 

asymmetry between the lower and the upper half of the measured spectra display, while refined 746 

spectra demonstrate perfect symmetry. This may be due to heterogeneities of the sample in the 747 

DAC, e.g. some grains on the periphery of the cell are subjected to lower pressures and 748 

deviatoric stress. To accommodate this, use only one half of the diffraction image. Since we 749 

imposed axial symmetry of texture and stress state, the entire diffraction pattern is not needed to 750 

derive a reasonably accurate ODF. For this case, you may remove, e.g., spectra #36-71 from the 751 

analysis (refer to procedure for removing spectra in 5 and 14) and repeat your refinement.  752 

 753 

28. At the end of the refinement the refined cell parameter is 4.0103 (1) Å and the corresponding 754 

volume is ≈ 64.48 Å3. For radial diffraction the lattice parameter represents the strain resulting 755 

from the hydrostatic (pressure) component of the stress tensor. The derived pressure is ≈ 33.9 756 

GPa and the elastic tensor C11 = C22 = C33 ≈ 574.8 GPa, C12 = C13 = C23 ≈ 161.2 GPa, C44 = C55 = 757 

C66 ≈ 141.7 GPa; the differential macrostress 11 component is ≈ 1.26 GPa.  758 

In this analysis we have been mainly concerned with preferred orientation which is 759 

displayed as pole figures (Fig. 13a,b). For materials with fiber symmetry inverse pole figures that 760 

represent the probability of the fiber axis relative to crystal coordinates is an efficient way to 761 
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represent textures. Figure 13c is the inverse pole figure of the compression direction plotted in 762 

MAUD and Figure 13d the inverse pole figure after processing with BEARTEX.  The texture is 763 

rather sharp with a pole density maximum of ≈ 11.5 multiples of a random distribution, located 764 

close to 001 (Fig. 13d), as observed previously (e.g., Merkel et al., 2002; Lin et al., 2009). 765 

 766 

IV. CONCLUSIONS 767 

Synchrotron X-rays provide a powerful method for quantitative texture analysis of 768 

materials. Depending on sample size, beam size and wavelength, small (< 100 µm3) to large 769 

volumes (> 200 mm3) can be analyzed, and different sample equipment can be used to impose 770 

different conditions on the sample (e.g., high pressure, high temperature, anisotropic stress). 771 

Compared to neutron diffraction, electron backscatter diffraction or pole-figure goniometry, data 772 

acquisition is fast, but data analysis is non-trivial. For complex polyphase materials (such as the 773 

shale sample) a careful manual procedure is necessary. Further complications arise for high 774 

pressure experiments, where anisotropic stresses need to be accounted for. MAUD incorporates a 775 

set of methods able to account for preferred orientations, anisotropic stresses and microstructural 776 

characteristics of material. Here we provided only a brief overview of these and simplified step-777 

by-step procedures that give general directions for the analysis, while highlighting some possible 778 

complications. Knowledge of the instrument, sample, and experimental setup is necessary to 779 

adjust these procedures to each specific case and obtain convincing results. 780 
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Tables 877 

Table 1 Phase volume and weight fractions of minerals in shale (in %), with and without 878 

imposed axial symmetry of texture. 879 

 880 

 Vol. Axial Wgt. Axial Vol. No symm. Wgt. No symm. 

Kaolinite 6.8 6.2 7.2 6.6 

Illite-mica 23.7 23.7 26.2 26.1 

Illite-smectite 31.4 29.2 30.5 28.3 

Quartz 31.9 29.9 29.9 27.9 

Pyrite 6.2 11.0 6.3 11.1 

 881 

Table 2 Texture information for phyllosilicates in shale after processing in BEARTEX, pole 882 

densities in m.r.d. 883 

 884 

 Max  

axial 

Min  

axial 

Max  

No symm. 

Min  

No symm 

Kaolinite 001 6.84 0.22 5.14 0.31 

Illite-mica 100 8.50 0.12 7.78 0.25 

Illite-smectite 100 3.83 0.39 3.70 0.30 

 885 

Table 3 Texture information for magnesiowuestite after processing data in BEARTEX; pole 886 

densities of different pole figures and inverse pole figure (IPF) in m.r.d. 887 

 888 

 Max  Min    

001 5.70 0.33   

110 1.59 0.47   

111 2.11 0.12   

IPF 10.74 0.11   

 889 

890 
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Figure Captions  891 

 892 

Figure 1. (a) Slab of shale embedded in epoxy and mounted on a pin. (b) Pole figure coverage 893 

with a single image, bedding plane normal is at A. When cylindrical symmetry is imposed 894 

bedding plane normal is rotated to B by a chi rotation; each point covers a circle around B on the 895 

pole figure (c) Coverage with seven images recorded at different sample tilts omega, (d) after 90º 896 

rotation around chi to bring the bedding plane normal into the center. 897 

 898 

Figure 2. 2D synchrotron diffraction images. (a) Kimmeridge shale with many phases, some with 899 

strong preferred orientation. (b) LaB6 standard, rather coarse-grained and with some impurities. 900 

(c) Radial diffraction DAC experiment on magnesiowuestite. Arrow points to a diffraction spot 901 

from diamond.  902 

 903 

Figure 3. Stack of diffraction spectra for Kimmeridge shale, omega = 0 tilt image. Experimental 904 

data at bottom and Rietveld fit on top. Some diffraction lines are labeled. 905 

 906 

Figure 4. Window in MAUD to define background peaks. 907 

 908 

Figure 5. Two diffraction spectra of Kimmeridge shale with scattering lattice planes parallel to 909 

bedding plane on top and perpendicular to it at bottom. Crosses are measured data and line is 910 

Rietveld fit. Below the spectra is a list of contributing phases and their corresponding diffraction 911 

peak positions are marked with ticks. 912 

 913 

Figure 6. Pole figures of basal planes of kaolinite, illite-mica and illite-smectite for Kimmeridge 914 

shale. (a) Derived from a single image, imposing fiber symmetry. (b) Result for 7 images without 915 

imposing symmetry. The corresponding pole figure coverage is shown in Fig. 1d. Equal area 916 

projection on the bedding plane, contours in multiples of a random distribution. 917 

 918 

Figure 7. Pole figures 100 of kaolinite and 001 of illite-mica and illite-smectite for Kimmeridge 919 

shale without imposing sample symmetry. The corresponding pole figure coverage is shown in 920 
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Fig. 1d. Equal area projection on the bedding plane, contours in multiples of a random 921 

distribution. 922 

 923 

Figure 8. (a,b) Schematic sketch illustrating the geometry of deformation experiments in a 924 

diamond anvil cell in radial diffraction geometry. (c) Actual diamond culets compressing a 925 

sample contained by a gasket. (d) Pole figure coverage for the magnesiowuestite DAC 926 

experiment. A gap is visible where two spectra are disabled because they contain a diffraction 927 

spot from the diamond. 928 

 929 

Figure 9. Measured (bottom) and calculated (top) diffraction spectra for magnesiowuestite; (a) at 930 

the beginning of the refinement. Lattice parameters are wrong and there is no texture or 931 

anisotropic stress in the model. Also note the black diffraction spot from diamond. (b) At the end 932 

of the refinement there is an excellent match in position, width and intensity. The compression 933 

direction is indicated by the arrow in (a) (larger 2θ angle corresponding to smaller d-spacing). 934 

 935 

Figure 10. Plot display of diffraction pattern of magnesiowuestite. Dots indicate user-defined 936 

positions for background interpolation. 937 

 938 

Figure 11. MAUD window for moment pole figures option to use as a stress/strain model. 939 

 940 

Figure 12. MAUD radial diffraction option panel for stress-strain refinement. 941 

 942 

Figure 13. Texture information for magnesiowuestite at 34 GPa represented as pole figures (a-b) 943 

and inverse pole figures (c-d). (a) Pole figures without imposing sample symmetry. (b) Pole 944 

figures imposing fiber symmetry. (c) Inverse pole figure of the compression direction plotted by 945 

MAUD. (d) Inverse pole figure after processing data in BEARTEX. Equal area projection, 946 

contours in multiples of a random distribution. 947 
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Figure 1. (a) Slab of shale embedded in epoxy and mounted on a pin. (b) Pole figure coverage with a single 
image, bedding plane normal is at A. When cylindrical symmetry is imposed bedding plane normal is rotated 
to B by a chi rotation; each point covers a circle around B on the pole figure (c) Coverage with seven images 

recorded at different sample tilts omega, (d) after 90º rotation around chi to bring the bedding plane normal 
into the center.  
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Figure 2. 2D synchrotron diffraction images. (a) Kimmeridge shale with many phases, some with strong 
preferred orientation. (b) LaB6 standard, rather coarse-grained and with some impurities. (c) Radial 
diffraction DAC experiment on magnesiowuestite. Arrow points to a diffraction spot from diamond.  
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Figure 3. Stack of diffraction spectra for Kimmeridge shale, omega = 0 tilt image. Experimental data at 
bottom and Rietveld fit on top. Some diffraction lines are labeled.  
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Figure 4. Window in MAUD to define background peaks.  
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Figure 5. Two diffraction spectra of Kimmeridge shale with scattering lattice planes parallel to bedding plane 
on top and perpendicular to it at bottom. Crosses are measured data and line is Rietveld fit. Below the 

spectra is a list of contributing phases and their corresponding diffraction peak positions are marked with 

ticks.  
213x123mm (200 x 200 DPI)  

 

 

Page 37 of 45

Cambridge University Press

Powder Diffraction



For Review
 O

nly

  

 

 

Figure 6. Pole figures of basal planes of kaolinite, illite-mica and illite-smectite for Kimmeridge shale. (a) 
Derived from a single image, imposing fiber symmetry. (b) Result for 7 images without imposing symmetry. 
The corresponding pole figure coverage is shown in Fig. 1d. Equal area projection on the bedding plane, 

contours in multiples of a random distribution.  
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Figure 7. Pole figures 100 of kaolinite and 001 of illite-mica and illite-smectite for Kimmeridge shale without 
imposing sample symmetry. The corresponding pole figure coverage is shown in Fig. 1d. Equal area 

projection on the bedding plane, contours in multiples of a random distribution.  

114x43mm (300 x 300 DPI)  

 

 

Page 39 of 45

Cambridge University Press

Powder Diffraction



For Review
 O

nly

  

 

 

Figure 8. (a,b) Schematic sketch illustrating the geometry of deformation experiments in a diamond anvil 
cell in radial diffraction geometry. (c) Actual diamond culets compressing a sample contained by a gasket. 
(d) Pole figure coverage for the magnesiowuestite DAC experiment. A gap is visible where two spectra are 

disabled because they contain a diffraction spot from the diamond.  
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Figure 9. Measured (bottom) and calculated (top) diffraction spectra for magnesiowuestite; (a) at the 
beginning of the refinement. Lattice parameters are wrong and there is no texture or anisotropic stress in 
the model. Also note the black diffraction spot from diamond. (b) At the end of the refinement there is an 

excellent match in position, width and intensity. The compression direction is indicated by the arrow in (a) 
(larger 2θ angle corresponding to smaller d-spacing).  
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Figure 10. Plot display of diffraction pattern of magnesiowuestite. Dots indicate user-defined positions for 
background interpolation.  

1482x884mm (72 x 72 DPI)  

 

 

Page 42 of 45

Cambridge University Press

Powder Diffraction



For Review
 O

nly

  

 

 

Figure 11. MAUD window for moment pole figures option to use as a stress/strain model.  
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Figure 12. MAUD radial diffraction option panel for stress-strain refinement.  
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Figure 13. Texture information for magnesiowuestite at 34 GPa represented as pole figures (a-b) and 
inverse pole figures (c-d). (a) Pole figures without imposing sample symmetry. (b) Pole figures imposing 
fiber symmetry. (c) Inverse pole figure of the compression direction plotted by MAUD. (d) Inverse pole 

figure after processing data in BEARTEX. Equal area projection, contours in multiples of a random 
distribution.  
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